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RESUMO 

 

A avaliação da densidade óssea é crucial para um prognóstico favorável do tratamento com 
implantes dentários. Desta forma, o presente estudo teve como objetivo avaliar 
quantitativamente a densidade óssea radiográfica nas regiões anterior e posterior ao forame 
mentual em mandíbulas edêntulas e correlacionar com a qualidade óssea clínica e 
radiográfica. Foram analisados oitenta sítios cirúrgicos em 27 pacientes edêntulos totais 
mandibulares triados para tratamento com implantes de acordo com critérios de elegibilidade, 
e aqueles incluídos fizeram tomografias computadorizadas de feixe cônico (TCFC). A seguir, 
foram alocados randomicamente em dois grupos: Grupo Teste – dois implantes convencionais 
(≥8-mm) entre os forames mentonianos e dois implantes extracurtos (4mm) na região posterior; 
Grupo Controle - dois implantes convencionais na região interforaminal. Os valores médios 
de densidade óssea tomográfica foram obtidos com o programa coDiagnostiX®, enquanto a 
densidade óptica tomográfica foi medida nos cortes axial, sagital e parassagital de sítios 
anteriores e posteriores ao forame mentual em escala de níveis de cinza no programa 
ImageJ®. Um radiologista independente e calibrado classificou os cortes parassagitais dos 
quatro sítios em tipo I, II, III ou IV de acordo com a classificação de Lekholm & Zarb (1985). A 
qualidade óssea clínica foi medida pela sensibilidade tátil do cirurgião no momento da 
colocação do implante de acordo com a classificação de Lekholm & Zarb (1985). Os valores 
de qualidade óssea clínica e radiográfica dos sítios anteriores e posteriores ao forame mentual 
foram comparados com o Teste t de Student e com o teste de Mann-Whitney para variáveis 
com e sem distribuição normal, respectivamente. O teste qui-quadrado foi utilizado para as 
variáveis categóricas. Os métodos foram correlacionados por meio do Teste de Correlação 
de Spearman (p < 0,01). O nível de confiança adotado foi de 95% (p < 0,05). Houve diferença 
estatisticamente significativa entre os valores da região anterior e posterior para os testes em 
todos os métodos avaliados (p<0,05), com exceção do corte sagital, após análise pelo 
ImageJ®. Os sítios posteriores apresentaram uma frequência maior de osso tipo II em região 
anterior e do tipo III em região posterior na análise do cirurgião e do radiologista, porém a 
correlação entre as análises foi fraca (r = 0,201). Houve uma forte correlação nas análises de 
densidade óssea entre os softwares ImageJ® e coDiagnostiX® (r = 0,762; p<0,001), entre o 
radiologista e o coDiagnostiX® (r = -0,641; p<0,001), entre o radiologista e o ImageJ® (r = -
0,578; p<0,001) e entre o clínico e o ImageJ® (r = -0,537;p<0,001). Este estudo também 
demonstrou moderada correlação entre a avaliação tátil do clínico com o coDiagnostiX®. Os 
resultados sugerem que a qualidade óssea da região anterior e posterior da mandíbula difere 
estatisticamente podendo afetar o prognóstico do tratamento com implantes, e os métodos de 
avaliação estão consistentemente correlacionados. Conclui-se que as avaliações 
radiográficas realizadas visualmente, e através de programas de imagens, são preditivas para 
avaliar a qualidade óssea, e que a avaliação clínica não pode ser usada isoladamente para a 
classificação da qualidade óssea. 

 

 

Palavras-chave: Implantes dentários, Densidade óssea, Tomografia computadorizada de 
feixe cônico, Mandíbula edêntula. 
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ABSTRACT 

 

Evaluation of bone density is crucial for a favorable prognosis of dental implant treatment. Thus, 
the present study aimed to quantitatively evaluate the radiographic bone density in the anterior 
and posterior regions of the mental foramen in the edentulous jaws and correlate with the 
clinical and radiographic bone quality. Eighty surgical sites were analyzed in 27 patients with 
total mandibular edentulous screened for implant treatment according to eligibility criteria, and 
those included conical beam computed tomography (CBCT). They were then randomly 
allocated into two groups: Test Group - two conventional implants (≥8-mm) between the 
mentonum foramen and two extra-short implants (4mm) in the posterior region; Control Group 
- two conventional implants in the interforaminal region. The mean values of tomographic bone 
density were obtained with the coDiagnostiX® program, while tomographic optical density was 
measured in the axial, sagittal and parasagital sections of sites anterior and posterior to the 
gray-scale mental foramen in the ImageJ® program. An independent and calibrated radiologist 
classified the parasagital sections of the four sites into type I, II, III or IV according to the 
classification of Lekholm & Zarb (1985). Clinical bone quality was measured by the surgeon's 
tactile sensitivity at the time of implant placement according to the classification by Lekholm & 
Zarb (1985). Clinical and radiographic bone quality values of the sites before and after the 
mental foramen were compared with Student's t-test and Mann-Whitney test for variables with 
and without normal distribution, respectively. Chi-square test was used for categorical 
variables. The methods were correlated by the Spearman Correlation Test (p <0.01). The 
confidence level adopted was 95% (p <0.05). There was a statistically significant difference 
between the anterior and posterior values for the tests in all evaluated methods (p <0.05), 
except for the sagittal section, after ImageJ® analysis. The posterior sites presented a higher 
frequency of type II bone in the anterior region and type III bone in the posterior region in the 
surgeon and radiologist analysis, but the correlation between the analyzes was weak (r = 
0.201). There was a strong correlation in bone density analysis between ImageJ® and 
coDiagnostiX® software (r = 0.762; p <0.001) between radiologist and coDiagnostiX® (r = -
0.641; p <0.001) between radiologist and ImageJ® (r = -0.578; p <0.001) and between clinician 
and ImageJ® (r = -0.537; p <0.001). This study also showed a moderate correlation between 
clinician's tactile assessment and coDiagnostiX®. The results suggest that the bone quality of 
the anterior and posterior mandible differs statistically and may affect the prognosis of implant 
treatment, and the evaluation methods are consistently correlated. It is concluded that 
radiographic evaluations performed visually and through imaging programs are predictive of 
bone quality, and that clinical evaluation cannot be used in isolation for bone quality 
classification. 

 

 

Keywords: Dental Implants, Bone Density, Cone-Beam Computed Tomography, Edentulous 
Mandible. 
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INTRODUÇÃO 

 

Com o aumento da expectativa de vida da população houve também um aumento 

significativo da necessidade de tratamento reabilitador com próteses dentárias. De acordo 

com o levantamento SB Brasil (2010), 83,15% dos idosos utilizam próteses na arcada su-

perior e 51,99% na arcada inferior. Uma alternativa de reabilitação consiste na confecção 

de próteses removíveis de acrílico, que consistem em uma solução de tratamento simples 

e barata. No entanto, a maioria dos pacientes queixa-se da instabilidade principalmente da 

prótese total mandibular, causando-lhes limitações na dieta, dor na boca, problemas de 

fala e psicossociais, etc. (RAMOS et al., 2011). Um motivo para a retenção inadequada da 

prótese total inferior pode ser a reabsorção óssea do rebordo alveolar, sendo este processo 

progressivo e irreversível que depende de vários fatores, mas que pode ser minimizado 

pela confecção de novas próteses (NIKOLOVSKA et al., 2015). 

As próteses totais implanto-retidas são uma alternativa às próteses convencionais 

e aumentam a satisfação do paciente e sua qualidade de vida (SAVABI et al. 2013). Nesse 

contexto, o uso de implantes osseointegráveis vem permitir a confecção de reabilitações 

de maior sucesso clínico. As overdentures são opções reabilitadoras eficazes, definidas 

como próteses totais removíveis que se encaixam sobre raízes residuais ou implantes os-

seointegrados (ALLEN et al. 2006). Segundo Poluha et al. (2016), estas próteses são con-

sideradas um tratamento de baixa invasividade, custo reduzido e de fácil manuseio em 

comparação às próteses fixas, além de contribuir para a preservação do osso alveolar por 

um maior período de tempo e melhorar da eficiência mastigatória. Especialmente para a 

mandíbula edêntula, as overdentures apresentam-se como uma alternativa reabilitadora 

previsível e minimamente invasiva. 

A importância da qualidade óssea no prognóstico de implantes dentários tem sido 

bem documentada na literatura. Uma densidade óssea fraca é considerada um dos princi-

pais fatores de risco para falhas nos implantes, como consequência de processos de re-

paro ósseos prejudicados e reabsorção excessiva quando comparados a um osso com 

maior densidade (CHOI et al. 2011; PAUWELS et al. 2015; AL-EKRISH et al. 2018). Norton 

& Gamble (2001) afirmaram que o tipo e a arquitetura do osso influenciam sua capacidade 

de suporte de carga e demonstraram que ossos de pior qualidade estão associados a taxas 

de falha mais elevadas. Em relação às diferenças de densidade ósseas existentes na man-

díbula, os autores observaram que a região anterior possui um valor de densidade média 

maior que a região posterior. Consequentemente, a avaliação da densidade óssea em sí-

tios potenciais para colocação de implantes é crucial para um prognóstico favorável do 
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tratamento. Neste sentido, o uso de tomografia computadorizada de feixe cônico (TCFC) 

na terapia com implantes dentários surgiu com o intuito de facilitar o diagnóstico e melhorar 

o planejamento do tratamento  (BEHNEKE  et  al. 2012; BORNSTEIN et al. 2015 ; CHEN 

et al. 2008 ; WORTHINGTON et al. 2010 ). Com isso, o uso de programas de computador 

como ferramentas de análise de qualidade óssea tem se tornado um método eficaz e pre-

ciso de avaliação quantitativa dos sítios de colocação de implantes (Santos, 2018). No 

entanto, as evidências científicas sobre o papel do seu uso na avaliação da qualidade ós-

sea ainda são escassas. 

Desta forma, o presente estudo teve como objetivo avaliar quantitativamente a den-

sidade óssea radiográfica nas regiões anterior e posterior ao forame mentual em mandí-

bulas edêntulas, e correlacionar com a qualidade óssea clínica (transcirúrgica) e radiográ-

fica (visual). 

https://onlinelibrary.wiley.com/doi/full/10.1111/clr.13142#clr13142-bib-0008
https://onlinelibrary.wiley.com/doi/full/10.1111/clr.13142#clr13142-bib-0010
https://onlinelibrary.wiley.com/doi/full/10.1111/clr.13142#clr13142-bib-0016
https://onlinelibrary.wiley.com/doi/full/10.1111/clr.13142#clr13142-bib-0106
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1 REVISÃO DE LITERATURA 
 

1.1.  DENSIDADE ÓSSEA 
 

Segundo Pauwels et al. (2015), a maioria das escalas de classificação baseia-se na carac-

terização da morfologia trabecular seccional e da espessura do osso cortical. No entanto, não 

existe um único sistema universalmente aceito para classificar a qualidade óssea nos ossos 

maxilares. Linkow & Cherchève (1970) classificaram a densidade óssea em três categorias, 

sendo elas: Estrutura óssea de Classe I, tendo o tipo de osso ideal que consiste em trabéculas 

uniformemente espaçadas, com pequenos espaços esponjosos; Estrutura óssea de Classe 

II, onde o osso tem espaços esponjosos ligeiramente maiores, com menos uniformidade do 

padrão ósseo; e Estrutura óssea de Classe III, em que existem grandes espaços preenchidos 

por medula entre o trabeculado ósseo. Os autores afirmam que o osso da Classe III resulta 

em um implante instável, já o osso Classe II foi satisfatório para implantes, e o de Classe I era 

considerado com uma base muito sólida para as próteses implanto-suportadas. 

O método mais tradicional aplicado para classificação de qualidade óssea é o estabelecido 

por Lekholm & Zarb (1985). Quatro qualidades ósseas foram definidas baseadas tanto na 

radiografia e na sensação tátil experimentada pelo cirurgião no momento da colocação dos 

implantes: densidade 1 - Osso compacto inteiramente homogêneo; densidade 2 - camada 

espessa de osso compacto em torno de um núcleo de denso osso trabecular; densidade 3 - 

camada fina de osso cortical envolvendo osso trabecular mais denso, com resistência favorá-

vel; densidade 4 - camada fina de osso cortical que envolve um núcleo de osso trabecular de 

baixa densidade (Figura 1). 

 

Figura 1. Classificação da densidade óssea de Lekholm & Zarb (1985). 
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Misch (1998) introduziu uma classificação de densidade óssea com base na sensação 

tátil durante a perfuração para inserção do implante e relacionada com a densidade medida 

em imagens de TC, em Unidades Hounsfield (HU). Esta classificação compreendia: D1 sendo 

um osso cortical denso (>1250 HU); D2 sendo um osso com cortical espesso denso a poroso 

(850 a 1250 HU); D3 sendo um osso com cortical fina com osso trabeculado fino (350 a 850 

HU); D4 sendo um osso quase totalmente fino (150 a 350 HU) e D5 como sendo um osso não 

mineralizado ou imaturo (< 150 HU). 

Norton & Gamble (2001) sugeriram uma escala objetiva de densidade que foi baseada 

em valores médios de unidades Hounsfield (HU) tomadas a partir de tomografia computado-

rizada (TC), e que poderia ser usada para o tecido ósseo como classificação antes do trata-

mento com implantes. Os autores registraram que as densidades ósseas médias na mandí-

bula anterior, na mandíbula posterior, na maxila anterior e na maxila posterior foram 970, 669, 

696 e 417 HU, respectivamente. Desta forma, surgiu a necessidade de obter-se uma classifi-

cação objetiva e quantitativa da densidade óssea que possa ser empregada no pré- operatório 

e que não dependa da habilidade do cirurgião. 

Lindh et al. (2004) afirmaram que a densidade óssea (densidade mineral óssea, 

DMO) e qualidade óssea não são sinônimos. A qualidade óssea engloba outros fatores além 

da densidade óssea, como tamanho do esqueleto, arquitetura e orientação tridimensional 

das trabéculas e as propriedades da matriz, não sendo apenas uma questão de conteúdo 

mineral, mas também de estrutura. A qualidade óssea pode influenciar a estabilidade de 

implantes dentários e desempenha um papel significativo na falha precoce do tratamento 

com implantes. 

Recentemente, Al-Ekrish et al. (2018) observaram que várias espessuras e densidades de 

osso compacto e trabecular dentro de um único local pode levar a uma variabilidade na 

classificação subjetiva. Com o objetivo de fornecer diretrizes mais confiáveis para maior 

utilização e reprodutibilidade da classificação, eles propuseram uma classificação revista de 

Lekholm & Zarb que leva em conta todas as combinações possíveis de osso compacto e 

trabecular. Três examinadores avaliaram 47 cortes de TC dos maxilares usando o programa 

Adobe Photoshop®, aplicando a classificação proposta. Eles estabeleceram três novas 

classes (tipo 2b, tipo 2c e tipo 3b), que foram adicionadas à classificação anterior. As novas 

classes foram designadas como subclasses de tipos ósseos 2 e 3, como segue: Tipo 1 - osso 

compacto inteiramente homogêneo; tipo 2a - camada espessa de osso compacto em torno de 

um núcleo de osso trabecular denso; tipo 2b - camada espessa de osso compacto ao redor 

de um núcleo de osso trabecular de densidade média; tipo 2c - camada espessa de osso 

compacto ao redor de um núcleo de osso trabecular de baixa densidade; tipo 3a - camada 
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fina de osso compacto ao redor de um núcleo de osso trabecular denso; tipo 3b - camada fina 

de osso compacto ao redor de um núcleo de osso trabecular de densidade média; tipo 4 - 

camada fina de osso compacto ao redor de um núcleo de osso trabecular de baixa densidade. 

Essa classificação pode ser melhor visualizada através da Figura 2:  

 

 

1.2.  TOMOGRAFIA COMPUTADORIZADA 
 

O desafio de visualizar internamente o corpo humano começou a ser superado com 

os raios-x, melhorou com a ultrassonografia e teve um grande salto quando foi acoplado um 

computador para a realização de cálculos matemáticos a partir da intensidade dos fótons de 

raios-x, por Ambrose & Hounsfield (1972), ao inventar a Tomografia Computadorizada (TC), 

um método radiográfico que permite a reprodução de uma secção do corpo humano com fi-

nalidade diagnóstica. 

Neste método, a formação da imagem ocorre em cortes axiais do paciente, onde a 

fonte de raio-x (tubo) está fixada aos sensores em forma de arco e ficam em torno do paciente. 

O conjunto se move ao redor do paciente e a cada 360º ocorre o movimento de translação do 

paciente o que gera uma trajetória helicoidal ou espiral. A reconstrução dos dados de atenu-

ação de raios-x transmitido por algoritmos de programas específicos produz fatias de imagem 

adjacentes de volumes formando as imagens do paciente (ANGELOPOULOS et al. 2012). 

Assim, o termo tomografia é usado para designar "um sistema de técnicas radiológicas 

especiais, que possibilita o exame do corpo humano dividido em planos selecionados". 

Quando seguido pela designação computadorizada, indica um exame radiológico em que ca-

madas ou fatias dos tecidos são registradas por finos feixes colimados e a seguir, processadas 

FIGURA 2. CLASSIFICAÇÃO DAS DENSIDADES ÓSSEAS. ADAPTADO DE AL-EKRISH ET AL. (2018). 
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pelo computador (GALVÃO FILHO, 1998). Assim, uma imagem de TC é a representação grá-

fica da anatomia de uma fatia do corpo do paciente (ROMANS, 1995). 

A imagem de TC é uma imagem digital e baseia-se em três conceitos básicos: detector, 

conversor analógico-digital e computador. Um detector é um sistema que se destina a detectar 

variações ambientais de alguma natureza. Em TC, o tipo de detector utilizado é o detector de 

radiação. Assim, o detector de radiação é um dispositivo que, colocado em um meio onde 

haja campo de radiação, é capaz de indicar sua presença (TAUHATA et al. 2003). O conversor 

analógico-digital promove a conversão do sinal elétrico para o formato digital. Assim, as infor-

mações obtidas do detector de radiação formam os dados. Eles, por sua vez, são transmitidos 

para o computador, onde são armazenados na unidade central de processamento ou CPU 

(ROMANS, 1995). 

Para criar a imagem, o sistema precisa transformar um volume (voxel), dado pela es-

pessura de corte, em uma imagem bidimensional (expressa por pixels). É um processo de 

"aplainamento" da imagem. Uma média dos valores de atenuação dos raios X aos tecidos 

englobados dentro de cada unidade de volume escaneada é atribuída ao voxel correspon-

dente. A partir desta informação, o pixel expressará uma tonalidade da escala Hounsfield na 

tela do monitor (ROMANS, 1995). 

O número de TC é habitualmente referenciado como sinônimo de unidade Hounsfield. 

Ele é importante no processo de reconstrução da imagem, onde seu valor determina a lumi-

nosidade e localização espacial de cada pixel da matriz (BUSHONG, 1993). A escala Houns-

field, varia de –1000 (densidade do ar) a +1000 (densidade da cortical óssea), passando pelo 

zero (densidade da água) (FREDERIKSEN, 1994; LANGLAIS et al. 1995). Considera-se, as-

sim, que a água apresenta uma densidade neutra na imagem tomográfica. Deste modo, os 

tecidos de maior densidade são decodificados com um número positivo pelo tomógrafo e cha-

mados hiperdensos, enquanto os tecidos com densidade inferior à água recebem um número 

negativo e são denominados hipodensos (GARIB et al. 2007). Apesar de o uso de TC con-

vencional ser um método bem estabelecido e aceito, existe certa preocupação em relação à 

dosagem de radiação que essa técnica confere devido ao tempo total em que o paciente é 

submetido ao exame (EKETUBBE et al. 1992, 1993; FREDERIKSEN et al. 1995; DULA et al. 

1996). 
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1.3.  TOMOGRAFIA COMPUTADORIZADA DE FEIXE CÔ-
NICO 

 

 

Nos últimos anos, a tomografia computadorizada de feixe cônico (TCFC) dentária 

tem se tornado cada vez mais utilizada em planejamento de cirurgias odontológicas devido 

a seus benefícios de baixo custo de equipamento, baixa radiação e alta resolução (FRE-

DERIKSEN, 1995; KO et al. 2017). Uma grande vantagem da TC odontológica é que os 

programas que executam a reconstrução computadorizada das imagens podem ser insta-

lados em computadores convencionais, e não necessitam de uma estação de trabalho 

(workstation) como a TC tradicional, apesar de ambas serem armazenadas na linguagem 

DICOM (Digital Imaging and Communication in Medicine) (GARIB et al. 2007). 

Ludlow et al. (2006) afirmaram que a dose de radiação efetiva da tomografia com-

putadorizada odontológica varia de acordo com a marca comercial do aparelho  e com as 

especificações técnicas selecionadas durante a tomada (campo de visão, tempo de expo-

sição, miliamperagem e quilovoltagem). Contudo, de um modo geral, ela mostra-se signi-

ficantemente menor em comparação à tomografia computadorizada tradicional (SUKOVIC, 

2003). 

A TCFC permite a aquisição de imagens volumétricas verdadeiras da área dentoma-

xilofacial em alta resolução espacial (PAUWELS et al. 2013). Isso é combinado com um 

feixe cônico tridimensional de raios-x. A técnica do feixe cônico envolve uma rotação única 

de 360º da fonte de raios-x, onde há um movimento sincronizado da fonte e da estrutura 

de detectores que se movimentam em torno da cabeça do paciente, a qual se encontra 

estabilizada em uma estrutura parecida com um cefalostato. Em certos intervalos de 

tempo, projeções simples de imagens, conhecidas como “imagens base”, são obtidas cada 

uma com uma angulação levemente diferente da outra. Essas séries de projeções de “ima-

gens base” são referidas como dados de projeção. Programas que incorporam sofisticados 

algoritmos são aplicados a essas imagens nos três planos ortogonais (RINO NETO & 

ACORSSI, 2010). 

Os cortes axiais são selecionados pelo operador em uma visão lateral da cabeça, 

e são considerados reconstruções primárias ou diretas. Cada corte contíguo pode apre-

sentar uma espessura mínima inferior a 1mm. A partir do corte axial, obtêm-se as 

reconstruções secundárias, incluindo as reconstruções coronais, sagitais, os cortes per-

pendiculares ao contorno dos arcos dentários (ortorradiais ou trans-axiais), as reconstru-

ções em 3D e as imagens convencionais bidimensionais. O volume total da área 
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escaneada apresenta um formato cilíndrico, de tamanho variável, de acordo com a marca 

do aparelho, e compõe-se unitariamente pelo voxel. Na TCFC, o voxel é chamado de 

isométrico, ou seja, apresenta altura, largura e profundidade de iguais dimensões (FAR-

MAN et al. 2006). Cada lado do voxel apresenta dimensão submilimétrica (menor que 

1mm, geralmente de 0,119 a 0,4mm) e, portanto, a imagem de TC apresenta ótima reso-

lução (GARIB et al. 2007). Segundo Varshowsaz et al. (2016), a unidade Hounsfield (HU) 

é o esquema padrão para escalonar o coeficiente de atenuação reconstruído em sistemas 

de TC médicas. Entretanto, os dados da TCFC têm uma quantidade maior de raios-X 

dispersos do que a TC helicoidal convencional. Isso pode melhorar o ruído nas imagens 

reconstruídas e, assim, afetar a detectabilidade de baixo contraste (ENDO et al. 2001 ). 

Devido à dispersão e aos artefatos, Yoo & Yin (2006) sugerem que os valores de HU na 

TCFC não são válidos e, portanto, o método de correlacionar os valores da densidade 

média óssea (DMO) à HU da TCFC não é ideal. Além disso, a dispersão e os artefatos 

na TCFC pioram em torno de tecidos não homogêneos com valores de HU reduzidos 

de até 200 HU, sugerindo que a HU na TCFC não é um método válido para avaliação da 

qualidade óssea. 

Segundo Hua et al. (2009), o endurecimento do feixe é um fenômeno resultante do 

aumento da energia média do feixe de raios X quando ele passa por um objeto. Devido a 

este endurecimento do feixe, o HU de certas estruturas, como tecido mole e osso, é alte-

rado. O detector único da TCFC tem uma largura de feixe maior do que o da TC de linha 

de detector múltiplo convencional (Figura 3). Isso causa uma distribuição angular não uni-

forme da intensidade do feixe de raios X conhecida como efeito heel, que leva a HU que 

também não possuem uniformidade. 

 

 FIGURA 3. COMPARAÇÃO DO TOMÓGRAFO TRADICIONAL (A) E DO TOMÓGRAFO 

DE FEIXO CÔNICO (B) COM A FONTE E O DETECTOR DE RAIOS-X. FONTE: SU-
KOVIC, 2003. 

https://onlinelibrary.wiley.com/doi/full/10.1111/j.1600-0501.2008.01677.x#b4
https://onlinelibrary.wiley.com/doi/full/10.1111/j.1600-0501.2008.01677.x#b4
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Varshowsaz et al. (2016) afirmam que em sistemas de TCFC, os valores de cinza 

são usados para representar os valores reconstruídos, embora ainda não tenha sido pro-

posto como um sistema padrão. Entretanto, a pesquisa disponível sobre a avaliação da 

qualidade óssea baseada em TCFC é escassa e dificultada pelas restrições técnicas ine-

rentes  aos  conjuntos  de  dados  de  imagens  de TCFC (HUA et al. 2009). 

 

 

1.4.  PROGRAMA DE PLANEJAMENTO CIRÚRGICO CODI-
AGNOSTIX® 

 

O coDiagnostiX® (Dental Wings Inc., Canadá) é um programa de planejamento de im-

plantes em 3D, que permite importar e processar conjuntos de dados de digitação de TC/TCV 

3D (“dicom” padrão). Guias de perfuração óssea podem ser projetadas com o coDiagnostiX®, 

os quais permitem a colocação do implante por meio de cirurgia guiada. Com base no plane-

jamento de implantes concluído, o programa permite a exportação de dados para a produção 

de guias cirúrgicas com recurso a sistemas de impressão em 3D. Incluso, está o caseX-

change, que é uma plataforma de comunicação interativa que permite a comunicação direta 

entre especialistas, dentistas, laboratórios, provedores de serviços e pacientes, oferecendo o 

compartilhamento de casos on-line com outros usuários do programa. Isto ajuda os profissio-

nais a fornecer resultados seguros e previsíveis, ao mesmo tempo em que aumenta a eficiên-

cia e a produtividade. No fluxo de trabalho analógico, o paciente tem de utilizar uma guia 

tomográfica, equipadas com pino de referências, durante os procedimentos de digitalização 

por TC/TCV. 

Além disso, o programa lê dados de imagens tridimensionais de escâners de modelo 

ou de moldes contendo informação de gengiva e dente. O programa possui um fluxo de tra-

balho totalmente digital que economiza tempo e não exige um modelo de digitalização. A in-

terface do programa pode ser vista através da Figura 4: 
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O planejamento é realizado através do cálculo de várias vistas, tais como: panorâmica 

virtual ou uma reconstrução tridimensional do conjunto de dados imaginológicos, através 

da análise dos dados imaginológicos e a inserção de implantes, pilares protéticos e ani-

lhas de perfuração. 

 

1.5.  PROGRAMA DE ANÁLISE DE IMAGENS RADIOGRÁFI-
CAS (IMAGEJ®) 

 

Segundo o próprio manual, o ImageJ® é um programa de processamento e análise 

de imagens Java de domínio público inspirado no NIH Image (National Institutes of Health). 

Ele é executado como um aplicativo para download, em qualquer computador, tendo dis-

tribuições em sistemas operacionais Windows®, Macintosh® e Linux®. Ele pode exibir, edi-

tar, analisar, processar, salvar e imprimir imagens de 8, 16 e 32 bits. Pode ler muitos for-

matos de imagem, incluindo  o “dicom”. Ele suporta “pilhas”, uma série de imagens que 

compartilham uma única janela. As operações consomem tempo com a leitura de arquivos 

de imagem, e podem ser realizadas paralelas com outras operações. 

O programa calcula estatísticas de área e valor de pixel de seleções definidas pelo 

usuário, mede distâncias e ângulos, cria histogramas de densidade e gráficos de perfil de 

linha e também suporta funções de processamento. Além disso, o programa possui uma 

FIGURA 4. IMAGEM DA TELA INICIAL DO PROGRAMA CODIAGNOSTIX®, UTILIZADO 

PARA PLANEJAMENTO VIRTUAL DA CIRURGIA GUIADA. FONTE: PROJETO DE PES-

QUISA ITI-UFSC. 
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calibração espacial que fornece medidas dimensionais do mundo real em unidades, como 

milímetros. A calibração de densidade ou escala de cinza também está disponível. A inter-

face inicial do programa pode ser observada na Figura 5: 

 

 

 

 

 

 

1.6. EVIDÊNCIAS CIENTÍFICAS 

Lindh et al. (1996) em seu estudo analisou o resultado diagnóstico da radiografia 

periapical na avaliação do padrão trabecular ósseo da mandíbula. Os espécimes de au-

tópsia mandibular foram radiografados. Antes do exame radiográfico, foram inseridos pinos 

de tântalo* (comprimento de 1,5 mm a 0,5 mm) no lado vestibular de cada secção desden-

tada das mandíbulas. Nas secções posteriores, um pino de tântalo foi inserido logo abaixo 

do forame mentoniano e outro pino foi colocado a 2 cm distalmente ao forame. Nas sec-

ções anteriores, um pino de tântalo foi inserido 1 cm de cada lado a partir da linha média. 

As secções foram examinadas com uma unidade de raios X odontológico Siemens Helio-

dent® EC (Siemens®, Bensheim, Alemanha) a 60 kVp e filme Ektaspeed Plus® (Eastman- 

Kodak® Co., Estados Unidos) com a película colocada paralelamente ao corpo mandibular. 

Sete observadores avaliaram as radiografias com o auxílio de uma classificação proposta 

com e sem imagens de referência e a classificação apresentada por Lekholm & Zarb 

(1985). A precisão foi estimada com base em medidas morfométricas do volume ósseo 

trabecular. A concordância do observador foi calculada como a probabilidade estimada de 

concordância entre e dentro dos observadores e como índice Kappa. Os autores obtiveram 

como resultado que a precisão geral foi de 58% e 50% sem imagens de referência. A pre-

cisão para avaliar o trabeculado denso foi maior (78%) do que para o trabeculado esparso 

(28%). A precisão da classificação proposta por Lekholm & Zarb não foi possível avaliar. A 

concordância interobservador variou entre 49% e 64% e a concordância intraobservador 

entre 75% e 86%. 

FIGURA 5.  INTERFACE INICIAL DO PROGRAMA IMAGEJ®. FONTE: PROJETO DE PES-

QUISA ITI-UFSC. 
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Ko et al. (2017) avaliaram a espessura do osso cortical crestal em várias regiões do 

osso maxilar através do uso de imagens pré-cirúrgicas de TCFC. Os autores utilizaram 

imagens coletadas de 173 pacientes (84 homens, 89 mulheres; idade média 49,86 anos) 

que haviam sido submetidos a implantes dentários entre 2013 e 2015. Antes do exame 

radiográfico, cada paciente estava usando stents cirúrgicos de diagnóstico que incorpora-

vam indicadores de guta percha radiopacos. As tomografias de feixe cônicos dentárias (AZ 

3000®, Asahi Roentgen, Japão) foram realizadas com os seguintes parâmetros técnicos: 

85 kV, 3 mA e uma resolução voxel de 150 mm. Um total de 661 locais de implantes den-

tários foram identificados nas imagens de TCFC dos 173 pacientes: 81 na mandíbula an-

terior, 122 na maxila anterior, 224 na mandíbula posterior e 234 na maxila posterior. As 

diferenças de espessura do osso cortical crestal entre a região anterior (maxila anterior e 

anterior da mandíbula) e a região posterior (maxila posterior e posterior da mandíbula) 

foram analisadas. A espessura da cortical óssea crestal foi de 0,12 a 3,65 mm (0,9560 mm, 

média 6DP). Os dados diferiram significativamente nos locais de implante dentário entre a 

região da maxila (0,7660 mm) e a região mandibular (1,186 mm; P <0,000). No entanto, 

não foram determinadas diferenças significativas entre a região anterior (0,9260 mm) e a 

região posterior (0,9660 mm; P5,36). A espessura do osso cortical crestal foi maior na 

mandíbula posterior (1,076 mm), seguida da mandíbula anterior (0,9960 mm), maxila ante-

rior (0,8260 mm) e maxila posterior (0,7560 mm). Os resultados estatísticos mostraram que 

a espessura do osso cortical da crista diferiu significativamente nos locais de implante entre 

todos os grupos revelando a maior espessura encontrada na mandíbula posterior, en-

quanto a menor na maxila posterior. 

Oliveira (2017) avaliou a qualidade óssea das diferentes regiões alveolares da maxila 

e da mandíbula por meio da classificação óssea proposta por Lekholm & Zarb (1985) (L & 

Z), radiografias panorâmicas e periapicais, quociente de estabilidade do implante (ISQ), 

torque de inserção (TI), microtomografia computadorizada (micro- CT) e histomorfometria. 

Foram avaliadas 60 áreas edêntulas, sendo 15 áreas de cada quadrante da maxila e da 

mandíbula. A qualidade óssea tipo III foi a mais frequente na maxila posterior (73,33%) e 

anterior (73,33%), já a tipo II foi mais frequente na mandíbula posterior (53,33%) e anterior 

(60,00%). Foi observada uma diferença estatisticamente significativa na densidade óssea 

óptica avaliada por meio de radiografias periapicais na região posterior da maxila (2,38 ± 

1,06) e posterior da mandíbula (3,84 ± 0,68), em relação às demais regiões alveolares 

avaliadas (p≤0,015). A estabilidade inicial dos implantes instalados na região posterior da 

maxila foi estatisticamente diferente dos instalados na região posterior  da mandíbula, tanto 

na avaliação por meio do TI como por meio do ISQ (p<0,05). Também foi possível detectar 

diferenças na qualidade óssea das regiões alveolares da maxila e da mandíbula por meio 
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de vários parâmetros da micro-CT (volume  ósseo (BV), p≤0,002; BV/BT, p≤0,044; super-

fície óssea (BS), p<0,027; superfície óssea/proporção do volume (BS/BV, p<0,05; densi-

dade da superfície óssea (BS/TV), p<0,05; número trabecular (Tb.N), p<0,01 e espaço 

trabecular (Tb.Sp), p<0,05). Quanto à análise de correlação, a densidade óptica avaliada 

por meio das radiografias periapicais correlacionou-se com o TI, com o ISQ e com vários 

parâmetros da micro-CT (BV, BV/BT, espessura trabecular (Tb.Th), Tb.N, BS/BV, fator de 

padrão ósseo trabecular (Tb.Pf) e índice de modelo estrutural (ISM)) (coeficiente de corre-

lação de Spearman (rho)≤0,471; p≤0,028). Entretanto, a radiografia panorâmica apresen-

tou apenas correlação com a BS e a BS/TV (rho≤0,290; p≤0,031). O TI apresentou corre-

lação com o ISQ, histometria e vários parâmetros da micro-CT (BV, BS/TV, Tb.Th, Tb.N, 

BS/BV, Tb.Pf, Tb.Sp, BV/BT) (rho≤0,550; p≤0,022). Em contrapartida, o ISQ não apresen-

tou correlação com nenhum parâmetro da micro-CT. A classificação L & Z mostrou corre-

lação com a densidade óptica avaliada por meio das radiografias periapicais, histometria, 

contagem de osteócitos, TI e vários parâmetros da micro-CT (BS/BV, Tb.Sp, Tb.Pf, BV, 

BS/TV, Tb.Th, Tb.N) (rho≤0,344; p≤0,042). Esses resultados sugerem que a classificação 

óssea de L & Z e o TI podem ser considerados métodos confiáveis na avaliação da quali-

dade óssea. O autor concluiu que as radiografias periapicais são um método aceitável na 

avaliação da qualidade óssea e que radiografia panorâmica, por sua vez, não se mostrou 

um método confiável para a avaliação da qualidade óssea. 

Santos (2018), em seu estudo clínico, avaliou quantitativamente a densidade óssea na 

região para colocação de implantes e correlacionou com a sensação tátil do cirurgião na 

instalação dos implantes em mandíbulas edêntulas totais. De acordo com a classificação 

de Lekholm & Zarb (1985) a densidade óptica tomográfica foi medida para sítios anteriores 

e posteriores ao forame mentoniano em escala de níveis de cinza no programa ImageJ®. 

Os valores médios de densidade óssea tomográfica foram obtidos também com o pro-

grama coDiagnostix™. Por fim, um radiologista independente e calibrado classificou os 

cortes parassagitais dos sítios anteriores e posteriores ao forame mentoniano em tipo I, II, 

III ou IV. O resultado encontrado foi que houve uma forte correlação (p < 0,001; r = 0,744) 

nas análises de densidade óssea entre os softwares ImageJ® e coDiagnostiX®. A correla-

ção entre a avaliação tátil do cirurgião e a avaliação tomográfica por um radiologista com 

a avaliação das escalas de densidade dos dois programas de computador foi moderada. 

Hakim et al. (2019) avaliaram a correlação dos parâmetros radiológicos pré- ope-

ratórios com os testes biomecânicos obtidos no período intraoperatório na maxila. Os au-

tores instalaram um total de 259 implantes na maxila de 99 pacientes. As unidades Houns-

field derivadas de feixe cônico (TCFC), valores de cinza do voxel e índice de tomografia 

computadorizada realizados no pré-operatório foram correlacionados com torque de 
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inserção do implante e capacidade de amortecimento (obtidos no período intraoperatório 

e 12 semanas depois) para avaliar a estabilidade primária do implante. Como resultado 

obtiveram valores de cinza do voxel e torque de inserção mostrando uma baixa correlação. 

Da mesma forma, foi encontrada uma baixa correlação entre a HU medida no pré-opera-

tório e o torque de inserção, bem como os valores intraoperatórios do Periotest®. Uma 

correlação moderada poderia, no entanto, ser avaliada entre o torque de inserção e intra-

operatório, bem como os valores do Periotest® de 12 semanas depois. Em contraste, uma 

alta correlação foi observada entre os valores de voxel cinza da TCFC e HU relacionada 

para que uma conversão de valores de cinza em HU possa ser sugerida. Os autores con-

cluíram que os parâmetros de densidade óssea baseados na TCFC correlacionam-se entre 

si e permitem a conversão de escalas de cinza em HU no pré-operatório. 

Triches et al. (2019) avaliaram três métodos de aferição da estabilidade dos implantes - 

Torque de Inserção (TI), Periotest® (PTV) e Osstell® (ISQ) - e o efeito da qualidade óssea 

avaliada no ato da cirurgia, considerando a espessura da camada cortical e a resistência 

do osso trabecular para categorizar o osso em quatro tipos (Lekholm & Zarb 1985) e em 

imagens de tomografias computadorizadas multislice (CT) ou de tomografias computado-

rizadas de feixe cônico (TCFC), avaliadas visualmente e por densidade óptica (variação de 

tons de cinza em 8 bits). As imagens de TC de diagnóstico pré-operatório foram reconstru-

ídas com o software ImageJ® para avaliação da qualidade óssea das regiões de interesse 

(ROIs). Foi avaliada a estabilidade primária de 45 implantes curtos (Straumann® SLActive 

RN SP 4.1 x 6mm). Foi encontrada correlação entre a qualidade óssea cirúrgica e a quali-

dade óssea visual, contudo não houve correlação entre a densidade óptica nem com a 

qualidade óssea cirúrgica, nem com a qualidade óssea visual. A estabilidade primária em 

osso tipo 4 (avaliado cirurgicamente) foi estatisticamente maior quando avaliada por PTV, 

onde a mediana foi -5,0 (variação: -6,0 a -2,5). A média do ISQ foi de 71,06 (±8,48) no osso 

tipo 1-2, 70,24 (± 4,24) no tipo 3 e 65,19 (± 8,38) no tipo 4 (p < 0,001); e o TI, onde 78,6% 

dos implantes colocados osso tipo 4 tiveram TI < 15Ncm. Desta forma, o estudo sugere 

existir uma correlação moderada entre os métodos de estabilidade primária e que os im-

plantes colocados em osso tipo 4 obtêm menor estabilidade inicial que nos outros tipos 

ósseos. 
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2. OBJETIVOS 
 

 

2.1.  OBJETIVO GERAL 
 

 

Avaliar quantitativamente a densidade óssea na região de colocação de implantes 

em mandíbulas edêntulas e correlacionar com a qualidade óssea clínica (transcirúrgica) e 

radiográfica (visual). 

 

 

2.2.  OBJETIVOS ESPECÍFICOS 
 

 

• Avaliar tomograficamente, em dois programas de planejamento cirúrgico virtual, a den-

sidade óssea em sítios anteriores e posteriores ao forame mentual para colocação de 

implantes em mandíbulas edêntulas; 

• Avaliar tomograficamente, em um programa de análise digital de imagens, a densidade 

óptica, expressa como variação de níveis de cinza, em sítios anteriores e posteriores 

ao forame mentual para colocação de implantes em mandíbulas edêntulas; 

• Avaliar visualmente, nas imagens parassagitais das tomografias computadorizadas de 

feixe cônico, a qualidade óssea em sítios anteriores  e posteriores ao forame mentual 

para colocação de implantes em mandíbulas edêntulas; 

• Avaliar clinicamente a qualidade óssea trans-cirúrgica em sítios anteriores e posterio-

res ao forame mentual para colocação de implantes em mandíbulas edêntulas. 
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3. MATERIAIS E MÉTODOS 
 

 

3.1. DELINEAMENTO DO ESTUDO 
 

O trabalho é uma continuação do Trabalho de Conclusão de Curso da coorienta-

dora deste trabalho, Tarla Thaynara Oliveira dos Santos, e trata-se de um recorte do ma-

croprojeto de pesquisa intitulado “Fatores de Risco para Próteses Totais Retidas por Im-

plantes Extra-Curtos em Mandíbulas Severamente Reabsorvidas – Um Ensaio Clínico 

Randomizado” (Sigpex-UFSC nr. 2019.00379). Este estudo consiste em um ensaio clínico 

randomizado controlado e cego, coordenado pelo Prof. Dr. Luis André Mezzomo. 

Os custos envolvidos no tratamento previsto neste estudo foram integralmente co-

bertos por financiamentos do International Team for Implantology (ITI), do Conselho Naci-

onal de Desenvolvimento Científico e Tecnológico (CNPq), e da empresa Straumann® 

Dental Implant System (Suíça). 

 

 

 

3.2.  AVALIAÇÃO DO COMITÊ DE ÉTICA 
 

 

O presente trabalho, por envolver pacientes e documentações clínicas, foi subme-

tido ao Comitê de Ética em Pesquisa com Seres Humanos da Universidade Federal de 

Santa Catarina (CEPSH- UFSC), e obteve aprovação em fevereiro de 2016 (Parecer nº 

1.452.492, Anexo 1). Os pacientes que atenderam aos critérios de elegibilidade forneceram 

o Termo de Consentimento Livre e Esclarecido (TCLE, Anexo 2) assinado, concordando 

com a participação na pesquisa. Os atendimentos foram realizados por alunos de Gradu-

ação em Odontologia da UFSC, sob supervisão e responsabilidade do investigador princi-

pal (Prof. Dr. Luís André Mendonça Mezzomo) e demais colaboradores. 
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3.3. CÁLCULO AMOSTRAL 
 

O cálculo amostral foi realizado levando em consideração o desfecho primário do estudo 

principal (perda óssea marginal), e usando as médias e desvio-padrão de estudos prévios 

(SLOTTE et al. 2012, 2015) com o programa Stata® versão 14.1 (Stata Corp LP, EUA). 

Nestes estudos, a alteração óssea radiográfica média em torno de implantes de 4-mm su-

portando próteses parciais fixas na região posterior, do baseline (instalação da prótese) 

até 12 meses, foi de 0,43mm (CI: 0,31-0,59; p< 

.001) e de 12 a 24 meses de 0,11mm (CI: 0,01-0,23; p< .056). Um cálculo do poder amos-

tral foi conduzido supondo não haver uma perda óssea crestal maior do que 0,3mm entre 

1 e 2 anos de acompanhamento para os implantes de 4-mm. Esta hipótese foi testada com 

um poder de 80%, desvio-padrão de 0,3, ao valor de p < 0.05. 

Supondo que 0,3mm é o tamanho da diferença média na altura óssea considerada 

importante entre os grupos teste e controle, uma amostra de 17 (dezessete) pacientes por 

grupo seria necessária para detectar uma diferença como estatisticamente significante (Ta-

bela 1). 

TABELA 1. CÁLCULO AMOSTRAL CONSIDERANDO UMA DIFERENÇA MÉDIA DE 0,3 MM NA ALTURA ÓSSEA CRES-

TAL COMO ESTATISTICAMENTE SIGNIFICANTE (LINHA 2). 

+-----------------------------------------------------------------------------------------------------------+ 

Alph A Poder N N1 N2 Diferença 

m 

1 

m 

2 
Dp 

.05 .8 74 37 37 -0.2 8 7.8 .03 

 

.05 

 

.8 

 

34 
17• 

 

17• 

 

-0.3 

 

8 

 

7.7 

 

.03 

.05 .8 20 10 10 -0.4 8 7.6 .03 

.05 .8 14 7 7 -0.5 8 7.5 .03 

.05 .8 12 6 6 -0.6 8 7.4 .03 

.05 .8 10 5 5 -0.7 8 7.3 .03 

.05 .8 8 4 4 -0.8 8 7.2 .03 

.05 .8 8 4 4 -0.9 8 7.1 .03 

.05 .8 6 3 3 -1.0 8 7.0 .03 

+-------------------------------------------------------------------------------------------------------+ 
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Devido às características específicas da amostra e de maneira a compensar espera-

das taxas de desistências ou perdas do acompanhamento moderadas ao longo do estudo, 

o tamanho mínimo da amostra foi aumentado para 20 (vinte) pacientes por grupo, totali-

zando 40 participantes. 

 

3.4. RECRUTAMENTO E SELEÇÃO DE PACIENTES 
 

Os pacientes foram triados a partir das Clínicas do Curso de Graduação em Odonto-

logia da Universidade Federal de Santa Catarina (UFSC). 

 

Critérios de Elegibilidade 

 

• Critérios de Inclusão: 

 

Pacientes do gênero masculino e feminino com a mandíbula totalmente edêntula, 

de 40 a 75 anos de idade; 

 

 

• Critérios de Exclusão: 

 

1. Episódios prévios de falha de osseointegração de implantes na região de inte-

resse; 

2. Áreas onde aumento ósseo tenha sido realizado; 

3. Espaço inter-arcos reduzido; 

4. Diabetes não compensada; 

5. Tabagismo pesado (> 10 cigarros/dia); 

6. Imunodeficiência; 

7. Radioterapia de cabeça e pescoço; 

8. Pacientes submetidos a tratamento com bisfosfonados; 

9. Doença periodontal ativa na dentição remanescente; 

10. Pobre higiene oral; 

11. Presença de cisto ou neoplasia na região de interesse; 
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12.  Presença de bruxismo do sono, diagnosticado pelo questionário validado 

da American Academy of Sleep Medicine (AASM 2014, Anexo 3). 

 

Os pacientes que atenderam ao Estágio 1 dos critérios de elegibilidade foram iden-

tificados como potenciais de serem incluídos no estudo e foram convidados a submeter-se 

a uma radiografia panorâmica digital para o Estágio 2 do processo de seleção. 

 

 

● Critérios de Inclusão do Estágio 2: 

 

1. Pacientes com mandíbula severamente reabsorvida onde a altura óssea residual 

(entre 5- e 8-mm de osso acima do canal mandibular), observada na radiografia pa-

norâmica digital, limita a terapia convencional com implantes; 

2. Pacientes que não desejam ser submetidos a procedimentos de aumento ósseo. 

 

● Critérios de Exclusão do Estágio 2: 

Presença de bruxismo do sono, diagnosticado por meio do uso do dispositivo portátil 

Bruxoff® (Spes Medica s.r.l., Itália) que detecta a atividade eletrocardiográfica e eletromio-

gráfica da musculatura mastigatória, características do bruxismo do sono. Os pacientes 

que atenderam aos critérios de elegibilidade nos estágios 1 e 2 receberam duas cópias do 

Termo de Consentimento Livre e Esclarecido (TCLE, Anexo 2), o qual foi lido atenciosa-

mente. O pesquisador resolveu as dúvidas existentes, e após ocorreu a assinatura pelo 

participante da pesquisa, estando ele de acordo com o apresentado. 

 

3.5. PLANEJAMENTO CIRÚRGICO 
 

A etapa pré-instalação de implantes compreendeu as seguintes fases: 

 

1. Confecção de novas próteses totais convencionais: os pacientes incluídos na pes-

quisa foram submetidos à confecção de novas próteses totais convencionais superio-

res e inferiores, as quais foram confeccionadas em relação oclusal normal classe I, 
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contatos oclusais em relação cêntrica e contatos bilaterais balanceados em protrusão 

e lateralidade. 

2. Duplicação da prótese total inferior e confecção de guia tomográfica: A nova prótese 

total inferior foi duplicada em resina acrílica ativada quimicamente (RAAQ) no interior 

de uma duplicadora e, nas regiões dos dentes 33, 43, 36 e 46, foram colocadas guta-

perchas como material radiopaco, como exemplificado na Figura 6: 

 

 

 

 

 

 

 

3. Exame da tomografia computadorizada de feixe cônico (TCFC) e planejamento cirúr-

gico: O paciente foi orientado quanto ao uso da guia tomográfica e encaminhado 

para obtenção da TCFC na Márcio Correa Radiologia Odontológica (Florianópolis-

SC). O tomógrafo utilizado foi o Prexion 3D® (San Mateo, EUA), ajustado em 90kvp e 

4mA em tempo de exposição de 19s. O campo de visão (FOV - Field Of View), foi li-

mitado em 81,0cm e resolução de imagem (voxel) de 0,1mm. A obtenção dos exa-

mes foi realizada de maneira padronizada para todos os pacientes da pesquisa. 

4. O arquivo em formato “dicom” do exame foi enviado por correio eletrônico para os 

investigadores da pesquisa, os quais o abriram no programa coDiagnostiX® (Dental 

Wings, Canadá) para planejamento da cirurgia de  implantes. Os sítios de eleição para 

os implantes (43, 33, 46 e 36), independente do grupo experimental a que o paciente 

foi randomicamente alocado posteriormente, foram analisados individualmente no pro-

grama por um único examinador, calibrado e diferente do operador. Implantes extra- 

curtos (4-mm) foram virtualmente colocados na região dos primeiros molares 

FIGURA 6. GUIA TOMOGRÁFICO OBTIDO ATRAVÉS DA DUPLICAÇÃO DA PRÓTESE DO PACIENTE, CONFECCIO-

NADO EM RESINA ACRÍLICA QUIMICAMENTE ATIVADA (RAAQ) E GUTA-PERCHA NA REGIÃO DOS DENTES 46, 
43, 33 E 36. FONTE: PROJETO DE PESQUISA ITI – UFSC. 
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inferiores, enquanto implantes convencionais (≥8-mm), ambos com diâmetro de 

4.1mm, foram virtualmente colocados na região dos caninos, como demonstrado na 

Figura 7: 

 

 

 

 

 

 

 

5. Randomização e alocação dos pacientes (Grupo Teste vs. Grupo Controle): A rando-

mização foi realizada através de sorteio. Foram confeccionados 25 cartões, medindo 

4 cm x 10 cm, com a palavra “teste” e outros 25 cartões  com a palavra “controle”. Os 

cartões foram inseridos em envelopes opacos, de mesma cor, devidamente lacrados 

e misturados. A alocação dos pacientes em cada um dos grupos permaneceu em si-

gilo até o momento da instalação dos implantes (T1), quando um envelope foi esco-

lhido aleatoriamente e aberto por uma pessoa não participante do estudo. Antes da 

colocação dos implantes (T1), o grupo ao qual o paciente foi alocado foi então reve-

lado tanto para o paciente quanto para o operador. Os pacientes foram alocados em 

dois grupos experimentais, de acordo com o número de implantes, responsáveis por 

reter uma prótese total removível: 

 

● Grupo Teste: Dois implantes convencionais (≥8mm) na região anterior (re-

giões do 33 e 43) e dois implantes curtos (4-mm) na região posterior (regi-

ões 36 e 46), acima do canal mandibular (n =25). 

● Grupo Controle: Dois implantes convencionais (≥8-mm) na região anterior 

(regiões do 33 e 43) apenas (n = 25). 

 

 

 

Figura 7. Imagem de corte panorâmico obtida após o planejamento digital, onde foram colocados virtual-

mente os implantes guiados pela guta-percha presente no guia tomográfico. Fonte: Projeto de Pesquisa ITI – 

UFSC. 
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3.6. AVALIAÇÃO DA QUALIDADE ÓSSEA RADIOGRÁFICA 
 

A qualidade óssea radiográfica foi analisada por três diferentes métodos: densidade 

óssea tomográfica no programa coDiagnostiX®, densidade óptica no programa ImageJ  e 

qualidade óssea visual por um radiologista. 

 

3.6.1. Avaliação da Densidade Óssea Tomográfica – Programa coDiag-
nostiX® 

 

Para cada exame tomográfico dos participantes da pesquisa, e independente do 

grupo experimental ao qual estes foram alocados a posteriori, uma examinadora calibrada 

(Nathalia Bressan Fontana) realizou o planejamento cirúrgico para colocação de quatro 

implantes nas regiões do 43, 33, 46 e 36 no programa coDiagnostiX®, seguindo a orienta-

ção das guta perchas da guia tomográfica. A análise da densidade óssea média, em Uni-

dades Hounsfield (HU), das 4 regiões onde os implantes foram virtualmente colocados foi 

feita por meio da ferramenta que mede as densidades ósseas médias em dois diâmetros 

concêntricos diferentes ao redor do centro virtual do implante - 0mm e 2,5mm (Figura 8). 

 

 

•  

 

Os valores de densidade óssea medidas em unidades Hounsfield (HU) das regiões 

do 33 e 43 nos diâmetros 0mm e 2,5mm foram agrupadas e anotadas como região anterior. 

Da mesma forma, os valores de densidade óssea medidas em Unidades Hounsfield (HU) 

das regiões do 36 e 46 foram agrupadas e anotadas como região posterior. A examinadora 

anotou as informações de densidade óssea em um formulário eletrônico no Google Forms® 

(Anexo 4) para cada um dos implantes colocados virtualmente. A densidade média foi 

Figura 8. Imagem das densidades médias medidas em 0mm (A) e 2,5 mm (B). Fonte: 

Projeto de Pesquisa ITI-UFSC. 
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anotada e o valor mantido em sigilo para não influenciar a decisão do operador no mo-

mento da cirurgia. 

 

3.6.2. Avalação da Densidade Óptica Tomográfica – Programa ImageJ® 

 

A densidade óptica foi analisada no programa ImageJ®, em três cortes radiográficos 

(axial, parassagital e sagital). A metodologia desta etapa do trabalho baseou-se no trabalho 

de Triches et al. (2013). Em função dos níveis de cinza das imagens disponíveis, foi reali-

zado um cálculo matemático, no qual todas as imagens foram convertidas para 8bits (256 

níveis de cinza). Desta forma, foi possível padronizar os valores de níveis de cinza, que 

variam numa escala de 0 a 255 (Figura 9), onde 0 representa valores escuros dentre os 

níveis de cinza da imagem, que correspondem à menor atenuação dos feixes de raios-x 

no momento da exposição, e 255 representa valores claros a brancos dentre os níveis de 

cinza, que correspondem à maior atenuação dos feixes de raios-x, dependendo do tipo do 

tecido irradiado. 

 

 

 

 

 

 

 

 

FIGURA 9. CLASSIFICAÇÃO DA ESCALA DE NÍVEIS DE CINZA NAS TOMOGRAFIAS. FONTE: PROJETO 

DE PESQUISA ITI-UFSC. 
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3.6.2.1. Avaliação da Densidade Óptica no Corte Axial 
 

No programa ImageJ®, foi selecionada a ferramenta File> Import> Image Sequence 

(Figura 10); abriu-se uma janela para seleção do arquivo “dicom” (Figura 11). Após a es-

colha do arquivo, selecionaram-se as opções de ajuste da sequência de imagens e clicou-

se em “ok” (Figura 12A). 

 

 

 

 

  

 

 

 

 

FIGURA 10. FERRAMENTAS PARA IMPORTAÇÃO DOS ARQUIVOS “DI-

COM” PARA RECONSTRUÇÃO DA IMAGEM TOMOGRÁFICA. FONTE: 
PROJETO DE PESQUISA ITI-UFSC 

FIGURA 11. JANELA PARA SELEÇÃO DA SEQUÊNCIA DE ARQUI-

VOS “.DICOM”. FONTE: PROJETO DE PESQUISA ITI- UFSC. 
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A      B
 

 

FIGURA 12. AJUSTES DA RECONSTRUÇÃO À ESQUERDA (A) E IMAGEM RECONSTRUÍDA À DIREITA (B). FONTE: 
PROJETO DE PESQUISA ITI-UFSC. 

  

 

 

A sequência de imagens do corte sagital foi aberta automaticamente (Figura 12B). 

Utilizando os comandos Image > Type > 8bit, padronizou-se a imagem em 8bits (Figura 

13). 
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FIGURA 13. SELEÇÃO DE IMAGEM EM 8 BITS. FONTE: PROJETO DE PESQUISA ITI-UFSC. 

 

 

A seguir, escolheu-se um corte axial que mostrava as 4 guta-perchas no seu maior 

diâmetro (Figura 14A). Selecionou-se a ferramenta Straight (Figura 14B). 

 

Figura 14. Corte axial que mostra todos os quatro pontos de guta-percha (A), 

e seleção da ferramenta Straight para realizar a reta (B). Fonte: Projeto de 

Pesquisa ITI-UFSC. 
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Foi, então, desenhada uma reta unindo as duas guta-perchas posteriores do lado 

esquerdo e direito. A reta foi fixada na imagem através do comando “control-D”. O mesmo 

repetiu-se na região anterior (Figura 15). 

 

Figura 15. Reta fixada na imagem unindo as gutas-perchas anteriores. Fonte: Projeto de Pes-

quisa ITI-UFSC. 

 

Selecionou-se outro corte da imagem em que se observava a extensão da mandí-

bula. Este corte foi padronizado de forma que aparecesse a saída dos dois forames men-

tuais (Figura 16). 

 

Figura 16. Imagem completa da mandíbula na região em que serão colocados os implan-

tes. Fonte: Projeto de Pesquisa ITI-UFSC. 
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Foi traçada uma reta (cuja medida o programa informa instantaneamente) medindo 

8mm (4mm do diâmetro do implante em questão com um acréscimo de 2mm em cada 

extremidade) (Figura 17). Esta linha foi fixada na imagem usando o comando “control-D”. 

 

 

Figura 17. Reta traçada perpendicular à reta referência que uniu as guta perchas. Fonte: 

Projeto de Pesquisa ITI-UFSC. 

 

Foi selecionada a ferramenta Wand (tracing) (Figura 18) para delimitar a área de 

interesse ou ROI (Region of Interest), com a qual foi contornada a imagem no rebordo no 

limite externo das corticais dado pela linha de referência marcada anteriormente ao lado 

do rebordo. Assim, a figura geométrica formada teve seu perímetro fechado com as outras 

duas faces cruzando perpendicularmente sobre a imagem do osso medular. 
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Figura 18. ROI (perímetro em amarelo) no corte axial para medição da densidade óp-

tica. Fonte: Projeto de Pesquisa ITI-UFSC. 

 

 

Após, foram determinadas quais as medições que seriam realizadas pelo programa, 

selecionando-se o caminho Analyze > Set measurements (Figura 19). 
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Figura 19. Seleção da ferramenta Analyze (A). Abriu-se automaticamente a janela 

“Set measurements” (B) com as opções dos dados a serem calculados pelo programa. 

Fonte: Projeto de Pesquisa ITI-UFSC. 

 

 

 

Os dados foram calculados pelo programa realizando o comando “control-M” ou 

selecionando-se o caminho Analyze > Measure (Figura 20). 

 

 

 

Figura 20. Ferramenta que calcula os dados automaticamente. Fonte: Projeto de 

Pesquisa ITI-UFSC. 
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Os dados foram registrados em uma tabela própria do ImageJ® (Figura 21A). A 

partir desta, os dados foram transferidos para uma planilha no Excel® através do comando 

File> Save As (Figura 21B). 

 

 

 

Figura 21. (A) Ferramenta de registros dos dados pelo ImageJ®. (B) Comando para salvar da-

dos. Fonte: Projeto de Pesquisa ITI-UFSC. 

 

 

 

O processo foi executado para cada uma das regiões de eleição para os implantes 

(33, 43, 36 e 46), até que fossem realizadas todas as medições de densidade óptica do 

corte axial. 
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3.6.2.2. Avaliação da Densidade Óptica no Corte Parassagital 

 

A abertura do arquivo “dicom” e padronização da imagem para análise do corte 

sagital foram as mesmas descritas anteriormente para o corte axial e demonstradas na 

sequência de Figuras 11 a 14. Foi traçada uma linha reta perpendicular ao rebordo (cuja 

medida o programa informa instantaneamente) de comprimento 25 mm no centro da guta-

percha, sendo seu sentido de vestibular para lingual (Figura 22). 

 

 

Figura 22. Reta perpendicular ao rebordo traçando o centro da guta percha. Fonte: Projeto 

de Pesquisa ITI-UFSC. 
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Para a reconstrução do corte parassagital, a partir da reta delimitada anteriormente, 

foi selecionado o comando Image > Stacks > Reslice [/] (Figura 23). 

 

 

FIGURA 24. IMAGEM AUTOMÁTICA PARA SELECIONAR A POSIÇÃO DA IMAGEM A SER FORMADA, SELECIONAR 

FLIP VERTICALLY E CLICAR EM OK. FONTE: PROJETO DE PESQUISA ITI-UFSC. 

 

 

Figura 23. Sequência de comandos para reconstrução do corte parassagital de interesse. 

Fonte: Projeto de Pesquisa ITI-UFSC. 
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Automaticamente, foi reconstruída a imagem do corte parassagital em outra janela. 

Foi selecionada a ferramenta Wand (tracing) para delimitar a área de interesse ou ROI 

(Figura 24), a qual foi contornada com 6mm de diâmetro (4mm do diâmetro do próprio 

implante acrescido de uma margem de segurança de 2mm), e o comprimento do implante 

obedecendo àquele estabelecido durante o planejamento no programa coDiagnostiX®, 

acrescido de uma margem de 2 mm de altura nas regiões anteriores como na Figura 25A. 

Esta manobra permite a exclusão da basilar da mandíbula, o que poderia gerar um viés 

para esta análise. Por último, nas regiões posteriores foi contornada 6mm de diâmetro por 

6mm de comprimento (4mm do implante extracurto acrescido de 2mm de margem), como 

na Figura 25B. 

 

 
 

FIGURA 25. IMAGENS NO CORTE PARASSAGITAL CONSTRUÍDA PARA ANÁLISE. FONTE: PROJETO DE PESQUISA 

ITI - UFSC 

 

Então, foi determinado quais as medições que foram realizadas pelo programa se-

lecionando-se o caminho Analyze > Set measurements (Figura 19). Os dados foram cal-

culados pelo programa realizando o comando “control-M” ou selecionando-se o caminho 

Analyze > Measure (Figura 20). Os dados foram registrados em uma tabela própria do 

ImageJ® (Figura 21A). A partir desta, os dados foram transferidos para uma planilha no 

 
B 
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Excel®, através do comando File> Save As (Figura 21B). O processo foi executado para 

cada uma das regiões de eleição para os implantes (33, 43, 36 e 46), até que fossem 

realizadas todas as medições de densidade óptica do corte parassagital. 

 

3.6.2.3. Avaliação da Densidade Óptica no Corte Sagital 

 

A abertura do arquivo “dicom” e padronização da imagem para análise do corte 

sagital foram as mesmas descritas anteriormente para o corte axial. A seguir, foi feito uma 

reta de referência unindo as duas guta-perchas do mesmo lado como demonstrado na 

Figura 26. A reta foi fixada através do comando “Control-D”. Foi realizado uma reta per-

pendicular à reta referência passando pelo centro da guta percha no sentido vestíbulo lin-

gual. A reta foi fixada usando o comando “Control-D”, como demonstrado na Figura 27. 

 

 

 

 

Figura 26. Reta de referência traçada para identificar as guta perchas. Fonte: Projeto de Pesquisa 

ITI-UFSC. 
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FIGURA 27. RETA PERPENDICULAR À RETA REFERÊNCIA PASSANDO PELO CENTRO DA GUTA-PERCHA NO SEN-

TIDO VESTÍBULO LINGUAL. FONTE: PROJETO DE PESQUISA ITI-UFSC. 

 

 

Selecionou-se outro corte da imagem em que se observava a extensão da mandí-

bula. Este corte foi padronizado de forma que aparecesse a maior extensão óssea da man-

díbula como mostra a Figura 28. Paralelo à reta de referência foi traçado uma reta no centro 

da mandíbula. A reta foi fixada na imagem através do comando “control-D”. O mesmo se 

repetiu na região posterior. 

 

 

 

FIGURA 28. RETAS TRAÇADAS PARALELAS. FONTE: PROJETO DE PESQUISA ITI-UFSC. 
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Para a reconstrução do corte sagital, a partir da reta delimitada anteriormente, foi 

selecionado o comando Image > Stacks > Reslice [/] (Figura 22). Automaticamente, for-

mou-se a imagem do corte sagital demonstrado na Figura 29. 

 

 

 

 

 

Foi traçada uma reta horizontal, cuja medida o programa informa instantaneamente, 

de 8mm (correspondente ao diâmetro do corpo do implante de 4,1mm + uma margem de 

segurança de 2mm de cada lado do implante). Esta linha foi fixada na imagem usando o 

comando “Control-D”, como demonstrado na Figura 30. 

FIGURA 29. CORTE SAGITAL COM A LINHA DE REFERÊNCIA DA GUTA PERCHA TRAÇADA ANTERIOR-

MENTE. FONTE: PROJETO DE PESQUISA ITI-UFSC. 
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FIGURA 30. RETA TRAÇADA (DE 8MM DE COMPRIMENTO) PERPENDICULAR À RETA DE REFERÊNCIA. FONTE: 
PROJETO DE PESQUISA ITI-UFSC. 

 

 

Foi selecionada a ferramenta Wand (tracing) (Figura 17) para delimitar a área de 

interesse ou ROI (region of interest), com a qual foi contornada a imagem no rebordo no 

limite externo das corticais com o comprimento de 8mm dado pelas linhas de referência 

marcadas no rebordo (Figura 31), sendo que a figura geométrica formada tinha seu perí-

metro fechado com as outras duas faces cruzando perpendicularmente sobre a imagem 

do osso medular (Figura 32) 

 FIGURA 31. RETA TRAÇADA PARALELA À RETA DE REFERÊNCIA. FONTE: PROJETO DE PESQUISA 

ITI-UFSC 
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FIGURA 32. ROI DELIMITADO PARA ANALISE AUTOMÁTICA. FONTE: PROJETO DE PESQUISA ITI-UFSC. 

 

 

Então, foram determinadas quais as medições que seriam realizadas pelo pro-

grama selecionando-se o caminho Analyze > Set measurements (Figura 19). Os dados 

foram calculados pelo programa realizando o comando “control-M” ou selecionando-se o 

caminho Analyze > Measure (Figura 20). Os dados foram registrados em uma tabela pró-

pria do ImageJ® (Figura 21A). A partir desta, os dados foram transferidos para uma planilha 

no Excel® através do comando File> Save As (Figura 21B). O processo foi repetido para 

cada uma das regiões de eleição para os implantes (33, 43, 36 e 46), até que fossem 

realizadas todas as medições de densidade óptica do corte sagital. 

Um formulário eletrônico com as informações de densidade óptica de cada uma das 

regiões eletivas para colocação dos implantes (anterior x posterior bilateral), elaborado no 

Google Forms® (Anexo 5), foi preenchido. A densidade óptica média foi anotada e o valor 

também mantido em sigilo para não influenciar a decisão do operador no momento da 

cirurgia. 

 

4.6.3. Avaliação da Qualidade Óssea Radiográfica Visual 
 

A metodologia desta etapa do trabalho também foi baseada no trabalho de Triches 

(2013). As imagens dos cortes parassagitais dos sítios de eleição para colocação dos 
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implantes foram avaliadas por um radiologista calibrado e independente (Dr. Vinicius Du-

tra), que classificou visualmente cada imagem recebida de acordo com a classificação ós-

sea proposta por Lekholm & Zarb (1985). As imagens foram codificadas e enviadas ao 

radiologista para que não houvesse indução no momento da classificação (cegamento). 

Este, por sua vez, classificou as imagens dos cortes parassagitais em osso tipo I, II, III ou 

IV e fez as anotações em um formulário específico (Anexo 6). 

 

 

 

 

 

4.6.4. Avaliação da Qualidade Óssea Transcirúrgica 
 

A qualidade óssea transcirúrgica foi avaliada subjetivamente como a resistência do 

osso no momento da perfuração óssea para instalação do implante (Figura 34), de acordo 

com a classificação de Lekholm & Zarb (1985): osso tipo I, II, III ou IV. No momento da 

cirurgia os pacientes foram alocados randomicamente para um dos grupos experimentais: 

Grupo Controle (recebendo 2  implantes convencionais que variaram de 8mm a 12mm na 

região interforames mentoniados apenas, para mantes uma overdenture) ou Grupo Teste 

(recebendo 2 implantes convencionais na região interforames mais 2 implantes extracurtos 

(4mm) na região de primeiros molares, posterior aos forames mentonianos ). Esta avalia-

ção foi realizada por um único operador (cirurgião), não conhecedor dos valores de densi-

dade óssea obtidas nos programas coDiagnostiX® e ImageJ® para cada uma das regiões 

de eleição para a pesquisa. 

 

Figura 33. Cortes parassagitais enviados para o radiologista. Fonte: Projeto de Pesquisa ITI- UFSC. 
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Figura 34. Broca esférica rompendo a cortical óssea no sítio de colocação do implante. Projeto 

de Pesquisa ITI-UFSC. 

 

 

 

 

4. ANÁLISE ESTATÍSTICA 
 

 

Para cada análise radiográfica (densidade óssea no programa coDiagnostiX® e 

densidade óptica no programa ImageJ®), os valores médios das regiões do 33 e da região 

do 43 foram somados e uma média e desvio-padrão da região anterior de mandíbula foi 

obtida. Da mesma forma, os valores médios das regiões do 36 e da região do 46 foram 

somados e uma média e desvio-padrão da região posterior de mandíbula foi obtida. A qua-

lidade óssea avaliada visualmente pelo radiologista, assim como a qualidade óssea trans-

cirúrgica (clínica) foram expressas em termos de frequência (%) de osso tipo I, II, III e IV 

para os sítios anteriores (33 e 43) e posteriores (36 e 46) ao forame mentual. 

A normalidade dos dados contínuos foi testada por meio do teste Kolmogorov- Smir-

nov. Os valores de qualidade óssea clínica e radiográfica dos sítios anteriores e posteriores 

ao forame mentual foram comparados com o Teste t de Student para amostras indepen-

dentes para variáveis com distribuição normal, ou o teste de Mann- Whitney para as vari-

áveis sem distribuição normal. O teste qui-quadrado foi utilizado para as variáveis categó-

ricas. Os métodos foram correlacionados por meio do Teste de Correlação de Spearman 

(p < 0,01). O nível de confiança adotado foi de 95% (p < 0,05). 
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5. RESULTADOS 
 

 

Foram triados 143 (cento e quarenta e três) pacientes nas clínicas do Curso de 

Graduação em Odontologia da UFSC no período entre 2016-2019. Destes, 113 (cento e 

treze) pacientes foram excluídos (Figura 35), pois não atenderam aos critérios de elegibili-

dade, enquanto 30 (trinta) pacientes foram incluídos na pesquisa e iniciaram o tratamento. 

FIGURA 35. RESULTADO DO PROCESSO DE TRIAGEM E MOTIVOS PARA EXCLUSÃO. FONTE: PROJETO DE PES-

QUISA ITI-UFSC 

 

 

Dos 30 pacientes incluídos na pesquisa, 27 (vinte e sete) foram selecionados por terem 

sido submetidos ao exame de TCFC, enquanto os outros três ainda estão em fase de con-

fecção das próteses totais convencionais. O fluxograma do processo de recrutamento e do 

tratamento dos pacientes encontra-se detalhado na Figura 36: 
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FIGURA 36. FLUXOGRAMA DOS ESTÁGIOS DOS PACIENTES NO ESTUDO. FONTE: PROJETO DE PESQUISA ITI- 
UFSC. 

 

 

Vinte e sete pacientes (17 mulheres; 61± 9,84 anos; 10 homens; 64±10,62 anos) 

foram submetidos à cirurgia de colocação de implantes. Destes, 13 (treze) foram alocados 

randomicamente no grupo teste, enquanto outros 14 no grupo controle. Assim, 80 (oitenta) 

implantes foram instalados até o momento na pesquisa: 54 (cinquenta e quatro) convenci-

onais (comprimento médio: 10,9mm ± 1,1mm; variação: 8-12 mm) e 26 (vinte e seis) ex-

tracurtos (4mm). 

Dois (2) implantes extracurtos foram perdidos antes da instalação da prótese e 

substituídos por novos implantes de mesmo comprimento, em uma posição mais mesial 

ou distal. Um implante convencional (12 mm) foi perdido na região de canino inferior es-

querdo. Desta forma, a taxa geral de sobrevivência dos implantes é de 97,5% (taxa de 

sobrevivência dos implantes convencionais: 98,15%; taxa de sobrevivência dos implantes 

extracurtos: 92,3%). Os pacientes tiveram o tratamento continuado com a substituição dos 

implantes perdidos por outros de igual comprimento, e permaneceram nos seus grupos 

experimentais. 

 

5.1. QUALIDADE ÓSSEA RADIOGRÁFICA 
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Cento e oito imagens (54 anteriores, 54 posteriores) de 27 pacientes estiveram dis-

poníveis para a avaliação da qualidade óssea radiográfica. 

 

 

5.1.1. Densidade Óssea Tomográfica - coDiagnostiX® 

 

As densidades ósseas médias para cada uma das regiões (anterior e posterior) 

estão expressas na Tabela 2. Os resultados mostraram haver diferença estatisticamente 

significativa (p = 0,003) entre os valores da região anterior (33 e 43) e posterior (36 e 46). 

 

 

TABELA 2. DENSIDADE ÓSSEA MÉDIA OBTIDA PELO PROGRAMA DE PLANEJAMENTO CIRÚRGICO DIGITAL, CODI-

AGNOSTIX®, DIVIDIDAS EM REGIÃO ANTERIOR (N = 54) E POSTERIOR (N = 54). 

 

 Anterior Posterior p-valor* 

Densidade 523,67 ± 222,01 400,69 ± 203,04 0,003 

*estatisticamente significativo (p < 0,05). Teste t de Student. 

 

 

 

 

5.1.2. Densidade Óptica Radiográfica (Níveis de Cinza) – ImageJ® 

 

Os resultados das densidades ósseas médias, assim como as áreas e perímetros 

médios analisados, para cada uma das regiões de eleição para a instalação dos implantes 

nos sentidos axial, sagital e parassagital estão expressos nas Tabelas 3, 4 e 5, respecti-

vamente. Houve uma diferença estatisticamente significativa nos valores de níveis de cinza 

entre a região anterior e posterior da mandíbula no corte axial (p=0,006) (Tabela 3). 

 

TABELA 3. DENSIDADE ÓPTICA OBTIDA PELO PROGRAMA IMAGEJ®, MEDIDAS EM CADA REGIÃO, NO CORTE 

 
Anterior Posterior 

p- valor* 
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Níveis de cinza (média ± 

d.p.) (min-máx) 
133,03 ± 

110,13 

(22-255) 

109,52 ± 16,18 

(18-255) 

0,006 

Área (média ± d.p) 64,35 ± 18,43 71,77 ± 18,66 0,014 

Perímetro (média ± d.p) 33,06 ± 4,47 34,96 ± 4,71 0,014 

*Teste não paramétrico de Mann-Whitney. 

 

 

Nos cortes sagitais, não houve uma diferença estatisticamente significativa (p= 0,061) 

nos valores de níveis de cinza entre a região anterior e posterior da mandíbula (Tabela 4). 

 

 

 

TABELA 4. DENSIDADE ÓPTICA OBTIDA PELO PROGRAMA IMAGEJ®, MEDIDAS EM CADA REGIÃO, NO CORTE 

SAGITAL (VALORES EXPRESSOS NA ESCALA X10³). 

 
Anterior Posterior 

p- valor* 

Níveis de cinza (média ± d.p.) 

(min-máx) 
106,03 ± 18,50 

(18-255) 

99,02 ± 19,25 

(24-255) 

0,061 

Área (média ± d.p) 85,39 ± 31,23 54,17 ± 12,94 <0,001 

Perímetro (média ± d.p) 38,08 ± 8,44 30,25 ± 4,48 <0,001 

* Teste não paramétrico de Mann-Whitney. 

 

 

Nos cortes parassagitais, houve uma diferença estatisticamente significa-

tiva (p < 0,001) nos valores de níveis de cinza entre a região anterior (33 e 43) e 

posterior (36 e 46) da mandíbula (Tabela 5). 

 

TABELA 5. DENSIDADE ÓPTICA OBTIDA PELO PROGRAMA IMAGEJ®, MEDIDAS EM CADA REGIÃO, NO CORTE 

 

 
Anterior Posterior p-valor* 

Níveis de cinza (média ± d.p.) 

(min-máx) 
111,37 ± 14,04 95,62 ± 21,54 
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(22-255) (20-255) <0,001 

Área (média ± d.p) 
71,46 ± 14,21 36,31 ± 4,34 <0,001 

Perímetro (média ± d.p) 
 

36,64 ± 3,82 

 

25,42 ± 4,36 

 

<0,001 

* Teste não paramétrico de Mann-Whitney. 

 

 

 

Na avaliação geral dos níveis de cinza (média entre os cortes axial, sagital e pa-

rassagital) dos sítios anteriores e posteriores ao forame mentual, a análise estatística 

revelou uma diferença estatisticamente significativa (p = 0,001). 

 

 

 

 

 

TABELA 6. DENSIDADE ÓPTICA OBTIDA PELO PROGRAMA IMAGEJ® (GERAL) (VALORES EXPRESSOS NA ES-

CALA X 10³). 

 
Anterior Posterior p- valor* 

Níveis de cinza (média ± d.p.) 

(min-máx) 
116,81 ± 39,27 

(28-255) 

101,38 ± 16,35 

(27-255) 

0,001 

Área (média ± d.p) 73,73 ± 12,35 54,08 ± 6,44 <0,001 

Perímetro (média ± d.p) 35,93 ± 3,11 30,21 ± 2,16 <0,001 

* Teste não paramétrico de Mann-Whitney. 
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5.1.3. Resultados da Qualidade Óssea Visual (Radiologista) 
 

 

Os resultados da distribuição da qualidade óssea obtidas pelo radiologista em 108 

sítios de colocação de implantes estão expressos na Tabela 7. Houve diferença estatística 

significativa (p<001). 

 

 

TABELA 7. DISTRIBUIÇÃO (%) DA QUALIDADE ÓSSEA VISUAL DOS CORTES PARASSAGITAIS NOS SÍTIOS ANTERI-

ORES E POSTERIORES OBTIDAS POR RADIOLOGISTA (LEKHOLM & ZARB 1985). 

  

Qualidade óssea 

radiográfica§ 
Anterior Posterior 

Tipo I 18,5% (n=10) 14,8% (n=8) 

Tipo II 66,7% (n=36) 22,2% (n=12) 

Tipo III 14,8% (n=8) 37,1% (n=20) 

Tipo IV 0% (n=0) 25,9% (n=14) 

§ Teste qui-quadrado. 

 

 

 

5.2. RESULTADOS DA QUALIDADE ÓSSEA CLÍNICA 

 

Oitenta implantes foram instalados (54 convencionais com média de 10mm e 26 

extra-curtos de 4mm). Os resultados da qualidade óssea intra-cirúrgica nos sítios de colo-

cação dos implantes, registrados pelo mesmo operador, estão expressos na Tabela 8. 

Houve diferença estatisticamente significativa (p=0,040). 
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TABELA 8. DISTRIBUIÇÃO DA QUALIDADE ÓSSEA CLÍNICA NOS SÍTIOS ANTERIOR (N = 22) E POSTERIOR (N = 10) 
OBTIDA DURANTE AS CIRURGIAS DE COLOCAÇÃO DE IMPLANTE, DE ACORDO COM A CLASSIFICAÇÃO DE 

LEKHOLM & ZARB (1985). 

 

Qualidade óssea clínica§ Anterior Posterior 

Tipo I 13,0% (n =7) 0% (n=0) 

Tipo II 42,6% (n=23) 38,5% (n=10) 

Tipo III 40,7% (n=22) 42,3% (n=11) 

Tipo IV 3,7% (n=2) 19,2% (n=5) 

§ Teste qui-quadrado 

 

5.3. CORRELAÇÃO ENTRE OS MÉTODOS 

Todas as correlações entre os diferentes métodos foram significativas, exceto en-

tre a avaliação pelo radiologista e pelo cirurgião, como representada na Tabela 9. 

 

TABELA 9. CORRELAÇÃO ENTRE OS MÉTODOS DE AVALIAÇÃO. 

 

 ImageJ® (n=108) Radiologista 

(n=108) 

Clínico 

(n=80) 

 

CoDiagnostiX® (n=108) 

Forte 

(r = 0,762) 
(p<0,001)* 

Forte 

(r = -0,641) 
(p<0,001)* 

Moderada 

(r = -0,449) 

(p<0,00 

1)* 

ImageJ®  

- 

Forte 

(r = -0,578) 
(p<0,001)* 

Forte 

(r = -0,537) 

(p<0,00 

1)* 

Radiologista  

- 

 

- 

Fraca 

(r = 0,201) 

(p=0,07 

3) 

Correlações (r): <0,3: fraca; 0,3 – 0,5: moderada; >0,5: forte. * Correlação significativa (p < 0,01). 
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A correlação entre a densidade óssea medida no programa coDiagnostiX® e a 

densidade óptica média no software ImageJ® está expressa na Figura 37, onde observa-

se uma reta linear crescente, mostrando assim uma forte correlação entre esses dois pro-

gramas de análise de imagens. Tal correlação foi positiva, ou seja, quando o valor de uma 

variável aumenta, o valor da outra também aumenta. 

 

 

FIGURA 37. GRÁFICO DE CORRELAÇÃO ENTRE OS PROGRAMAS CODIAGNOSTIX® (MÉDIA 0,0 E 2,5) E IMA-

GEJ® (MÉDIA GERAL: VARIÁVEL VM). 

 

 

Abaixo podemos observar a correlação entre os dados obtidos pelo programa co-

DiagnostiX® e os dados obtidos pela avaliação do radiologista das imagens tomográficas 

e do clínico segundo a classificação de Lekholm & Zarb (Tipo I, II, III e IV). No eixo x estão 

expressas as informações de qualidade óssea e no eixo y a classificação da densidade 

óssea em HU. Podemos observar que, quando houve uma diminuição da densidade óssea, 

a classificação atribuída pelo radiologista e pelo clínico aumentaram (de Tipo I a Tipo IV), 

como demonstrado nas Figuras 38 e 39, respectivamente. 
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FIGURA 38. CORRELAÇÃO ENTRE CODIAGNOSTIX® E AVALIAÇÃO RADIOGRÁFICA. 
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Com relação aos resultados do programa ImageJ®, também houve uma correlação 

significativa e forte. Isto é, os valores mais altos do ImageJ® são as classificações tipo I e 

tipo II dos dados radiológicos e clínicos como demonstrado nas Figuras 40 e 41, respecti-

vamente. 

 

 

 

 

 

FIGURA 40. CORRELAÇÃO ENTRE IMAGEJ® E A CLASSIFICAÇÃO DO RADIOLOGISTA 
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FIGURA 41. CORRELAÇÃO ENTRE O IMAGEJ® E A CLASSIFICAÇÃO CLÍNICA. 

 

 

6. DISCUSSÃO 
 

 

Este trabalho avaliou a qualidade óssea em sítios de mandíbulas edêntulas em 

que foram colocados implantes convencionais em região anterior e extra-curtos em região 

posterior. Quatro diferentes métodos de análise foram empregados, sendo três métodos 

tomográficos (ImageJ®, coDiagnostiX® e avaliação visual) e um método clínico obtido du-

rante as cirurgias. A qualidade e densidade óssea e óptica (HU e níveis de cinza) obtidos 

foram maiores na região anterior, independente do programa utilizado. Os resultados do 

presente estudo estão em concordância com os trabalhos de Norton & Gamble (2001) e 

Santos (2018). Neste último, a autora analisou, com uma amostra menor, a qualidade ós-

sea em sítios de mandíbulas edêntulas em que foram colocados implantes de titânio em 

região anterior e posterior. 

Considerando que o programa coDiagnostiX® fornece seus resultados em HU, era 

esperado que não houvesse correlação entre os métodos pois, segundo Varshowsaz et al. 

(2016), que avaliaram a correlação entre os valores de cinza obtidos da TCFC e das HU 

nas imagens de TC e concluíram que os sistemas de TCFC não foram capazes de mostrar 
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o valor exato da densidade do tecido.Também, contradizendo HUA et al. (2009) que des-

cobriram que alguns artefatos e radiação de dispersão são responsáveis pela ineficácia da 

TCFC na avaliação da densidade, que são inevitáveis devido ao projeto dos sistemas de 

TCFC e seus detectores. Considerando a ineficácia da TCFC na avaliação da densidade, 

a heterogeneidade do feixe de raios X na TCFC pode afetar os valores de HU e levar  à 

ausência de uma relação clara entre o valor do voxel na TCFC e a densidade mineral óssea 

proporcionada pela absorciometria de raios-X. Os artefatos como o endurecimento do feixe 

ou o efeito de salto podem diminuir a validade desses valores (KATSUMATA et al. 2007). 

Vários estudos mencionaram a diferença entre  os valores da TCFC e os valores da TC e, 

na maioria dos casos, os valores da  TCFC relatados foram maiores que os valores da TC. 

Parsa et al. (2013), mencionaram maior valor de cinza em seu estudo e acreditam que isso 

pode ser devido ao aumento do nível de ruído, espalhamento e artefatos específicos da 

tecnologia de escaneamento. Scarf & Farman (2010) propuseram que, embora houvesse 

uma associação entre as HUs fornecidas pela TC e o valor do voxel na TCFC, a variabili-

dade das medidas pela TCFC foi maior que a da TC. Eles acreditavam que era por causa 

do método de aquisição de imagem na TCFC. No entanto, Lagravère et al. (2008) encon-

traram uma relação linear em R2 (coeficiente de relação entre duas variáveis) entre os 

valores em TCFC e TC, e indicaram que os valores de TCFC foram geralmente maiores. 

Entretanto, nesse estudo sugere-se que, embora a HU fornecida pelo programa coDiag-

nostiX® não seja uma unidade própria da TCFC, a sua interpretação é semelhante à análise 

de níveis de cinza utilizado pelo ImageJ®, justificando a forte correlação entre os métodos. 

A avaliação da densidade óptica foi realizada no ImageJ  por um avaliador cali-

brado que obteve cortes nos sentidos axiais, parassagitais e sagitais, a fim de avaliar todas 

as dimensões dos sítios, dando assim mais precisão aos dados obtidos. A metodologia do 

corte parassagital da etapa realizada por Santos (2018) foi revista e todos os cortes refei-

tos, não mais contornando toda a cortical óssea na região anterior (33 e 43), e sim levando 

em consideração apenas o tamanho do implante planejado e instalado no momento da 

cirurgia. Para essa análise o ROI passou a ser o do comprimento do implante acrescido de 

uma margem de 2mm. O mesmo foi feito com o diâmetro do implante. Dessa maneira, 

houve uma redução dos valores médios de 127,00 ± 10,00 e 107,80 ± 12,82 HU para 

111,37 ± 14,04 (22- 255) e 95,62 ± 21,54 (20-255) para as regiões anterior e posterior, 

respectivamente. Assim, o fato de a cortical da base da mandíbula não fazer mais parte da 

região de interesse (ROI) sugere a presença de um osso menos denso em alguns dos 

locais, o que pode, possivelmente, ter diminuído os valores médios de cinza. Tal alteração 

está de acordo com Varshowsaz et al. (2016) ao afirmarem que a qualidade óssea é de-

terminada pela espessura do osso cortical, pela quantidade de trabéculas e mineralização. 
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Segundo Ko et al. (2017) a espessura do osso cortical da crista nos locais de implante 

dentário tem uma variação dependendo da sua região e diminuiu na seguinte ordem: pos-

terior da mandíbula (1,07 ± 0,47 mm)> anterior da mandíbula (0,99 ± 0,36 mm)> maxila 

anterior (0,82 ± 0,30 mm)> maxila posterior (0,75 ± 0,35 mm). 

Na análise clínica tanto a região anterior como a região posterior obtiveram maior 

frequência de osso tipo II e do tipo III, sendo que na primeira o menos frequente foi o tipo 

IV e na segunda não houve nenhum sítio classificado como tipo I. A avaliação da qualidade 

óssea visual obtida pelo radiologista na região anterior apresentou o tipo II como o mais 

frequente e o tipo IV o menos frequente, já na região posterior foi o tipo III e tipo IV foram 

os mais frequentes. Assim, os métodos de análise clínica e avaliação radiográfica apre-

sentaram uma correlação negativa. O fato dos avaliadores serem cegados de cada etapa 

pode ter contribuído para a fraca correlação entre o radiológico e a percepção tátil do ci-

rurgião no momento da colocação do implante. Isto reflete, assim, a dificuldade de obter 

uma avaliação subjetiva que seja fidedigna à qualidade óssea e reforça a necessidade de 

se obter um método objetivo de avaliação, que forneça maior confiabilidade ao clínico du-

rante a preparação do local de colocação do implante no pré-operatório. A não existência 

de um padrão ouro para análise de qualidade óssea para instalação de implantes sugere 

a necessidade de aprimorar as técnicas existentes e até as combinações das mesmas com 

o intuito de informar quantitativamente, de forma a ser reproduzida pelo clínico em sua 

prática diária. 

Salienta-se que neste trabalho foram tomados todos os cuidados necessários 

para a obtenção de informações relacionadas ao paciente padronizadas, tais como: tria-

gens dos pacientes, a confecção de guias tomográficos obedeceu aos padrões necessá-

rios para auxílio na obtenção e futura avaliação das imagens, os exames tomográficos 

também foram realizados em uma única clinica com o mesmo tomógrafo, os planejamentos 

cirúrgicos foram realizados por uma única avaliadora calibrada, as etapas cirúrgicas reali-

zadas por um cirurgião experiente, calibrado e cegado, e por fim um radiologista experi-

ente, calibrado e cegado de todas as etapas e informações obtidas dos exames de imagem 

dos pacientes que não fosse a analisada. 

Dentre as limitações do estudo estão o fato de que cada método utilizado foi ava-

liado por um apenas um examinador cegado das outras etapas. Sendo que, quanto mais 

avaliações de examinadores distintos fossem realizadas para cada método, mais dados de 

reprodutibilidade intra e inter- observador poderiam ter sido obtidos. Considera-se, também 

que, a dificuldade de recrutar pacientes que atendam aos critérios de elegibilidade e o 

tempo necessário para confecção de cada etapa fazem com que seja necessário estender 
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o prazo para aumentar a amostra e, portanto, o poder amostral seja maior. Dessa forma, 

o fato de o tamanho amostral atingido ser de apenas 67,5% do estabelecido pelo cálculo 

amostral também pode ter influenciado os resultados. O estudo terá sua continuação como 

um recorte do estudo experimental clínico, e a inclusão de mais pacientes permitirá uma 

reanálise dos dados de qualidade óssea tanto clínica quanto radiograficamente em man-

díbulas edêntulas. 
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7. CONCLUSÕES 
 

Este estudo mostrou que a densidade e a qualidade óssea dos sítios anteriores e 

posteriores da mandíbula diferem significativamente, e que os métodos de avaliação da 

qualidade e densidade óssea apresentam uma forte correlação. 

Além disso, foi possível concluir que a avaliação pré-operatória da qualidade ós-

sea nunca deve ser realizada com base na avaliação clínica isoladamente: esta deve ser 

baseada na combinação de informações clínicas com informações radiográficas. 
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Anexo 4. Questionário de densidade óssea radiográfica. 

 

 

 

 

Anexo 5. Questionário de densidade óptica analisada pelo programa Ima-

geJ® 
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Anexo 6. Ficha de Avaliação da Qualidade Óssea Respondida pelo Radiologista. 

 


